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all decisions relating to or use of the information provided herein.

The information contained in this publication is effective as of the publication date below and is subject
to change without notice.

This publication contains proprietary information that is protected by copyright. All rights are reserved.
No part of this document may be reproduced or transmitted in any form or by any means, electronic or
mechanical, or translated into another language, without the prior written consent of Deltek, Inc.

This edition published March 2026.
© Deltek, Inc.

Deltek’s software is also protected by copyright law and constitutes valuable confidential and
proprietary information of Deltek, Inc. and its licensors. The Deltek software, and all related
documentation, is provided for use only in accordance with the terms of the license agreement.
Unauthorized reproduction or distribution of the program or any portion thereof could result in severe
civil or criminal penalties.
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Overview

This document includes all of the enhancements, software issues resolved, and database changes that
were made in Cobra 8.7 Cumulative Update 01 through Cobra 8.7 Cumulative Update 03.

Custom Programs Affected

Sometimes an update can cause custom programs and reports to stop working as expected. Before
applying this update, consider whether you have any custom programs or reports in the application area
affected by the update. If so, contact a Deltek Support Services analyst at https://support.deltek.com

before you install the update.

Attention: For steps to install the cumulative update, see “Appendix A: Download and Install the
Cumulative Update” in this document.

Viewing the Help System
The Deltek Cobra Help System provides help for all areas of the Cobra application.

= To access all documents available for Cobra 8.7, click
https://help.deltek.com/Product/Cobra/8.7/GA.

= To access the printable version of the Cobra Help System, see Cobra Help System in Portable
Document Format. Take note that some of the links in the PDF version may not work.

= To view the collection of videos that will help you work with Cobra, see Cobra Videos.

Software Requirements (Compatibility Matrix)

To see the list of the supported and compatible technologies, see “System Requirements” in the Deltek
Cobra 8.7 Installation Guide.

For a compilete list of the recommended minimum software requirements, see the Deltek Product
Support Compatibility Matrix document, which you can download from the Deltek Support Center site.

Integration with PM Compass

If you are upgrading from one version of Cobra to another and are using PM Compass, ensure that you
install the version of the Cobra Integration for PM Compass file that supports the specific versions of
Cobra and PM Compass you plan to use.

= For PM Compass 8.4 or earlier, the integration file is typically released prior to or alongside the
PM Compass Cumulative Update (CU) and must be installed manually.

= For PM Compass 8.5 or later, the CU installer includes the integration installer, which
automatically installs the compatible Cobra engine—no separate installation is necessary.
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However, if there is no PM Compass CU release, but a Cobra integration file is available,
download it from DSM and run the installer manually.

Note: A new integration file is not required for every Cobra CU. If no new file is provided, the
previous version may be used if it remains compatible.

Attention: For more information on the PM Compass Cumulative Updates and Integration Releases,
download the related document from the Deltek Support Center site. If you have any questions,
contact a Deltek Support Services analyst.
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Cobra 8.7 Cumulative Update 03

Released: March 31, 2026

Enhancements

There are no enhancements in this release.
Software Issues Resolved
This section includes software issues resolved in this release.

Files » Integration Wizard-Project Data

Defect 2617833

Description: When you ran the Open Plan—Integration Wizard, Cobra encountered the “Alias 'TMPUDT" is
not found” error under any of the following conditions:

=  You integrated with an Open Plan master project and selected the Code Assignments and User
Fields and Resource Assignments options on the Action Selection page.

*  You selected the Status option on the Action Selection page and the Update Assignment %
Complete option on the Status page.

Customers Impacted: This defect affects customers using the Open Plan-Integration Wizard.
Workaround Before Fix: None.
Files Updated:

= Cobra.Process.dll

Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 11 (Defect 2361128).

Defect 2617830

Description: When you ran the Actual Cost-Integration Wizard, resource names in mixed case were
integrated into the CECODE column in the TPHASE table, even if the resource names in Cobra were in
upper case, which caused calculation errors.

Customers Impacted: This defect affects customers using the Actual Cost-Integration Wizard.
Workaround Before Fix: Do one of the following:

=  Option 1: Delete the imported data, update the import file so it matches the uppercase resource
name in the resource file, and then re-import the data.

= Option 2: Perform the following steps:
1. Create a new resource.

2. Copy the calculations from the original resource to the new resource.
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3. Click Tools » Replace Resource to replace the problematic resource with the new
resource.

4. Click Tools » Replace Resource again to replace the new resource with the original
resource.

5. Run the Recalc Wizard for the affected work packages.
6. Re-run the calculations.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 11 (Defect 1285093).
Files Updated:
= Cobra.Process.dll

Security Enhancements

There are no security enhancements in this release.

Database Changes

There are no database changes in this release.

Data Changes

There are no data changes in this release.

Documentation Changes

This section includes details of section changes in the printed documentation that are in addition to any
enhancements.

Deltek Cobra 8.7 Help System =  Fixed the typographical error in the “XML
Configuration File Sample” topic
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Cobra 8.7 Cumulative Update 02

Released: March 5, 2026
Enhancements
This section includes enhancements in this release.

Support for Ollama as an Al Service Provider

PPM Administrator (PPMA) now supports configuring Ollama connection settings through the Al tab on
the System menu form.

Attention: For more information on this enhancement, see the Deltek PPM Administrator 1.0.0

Cumulative Update 02 Release Notes.

As part of this enhancement, Cobra has been updated to ensure full compatibility and enable the
Narrative Score feature to function seamlessly when Ollama is selected as the Al service provider.

Attention: The "Enable the Narrative Score Feature” topic in the Cobra Help System has been

updated to reflect this change.

Software Issues Resolved

This section includes software issues resolved in this release.

Files » Integration Wizard-Project Data

Defect 2592089

Description: When you ran the Primavera-Integration Wizard to load control accounts and work
packages, and filters were already selected on the Filter page, some data might not have loaded if the
filter fields did not exactly match the project data, such as when extra spaces were included.

Customers Impacted: This defect affects customers using the Primavera-Integration Wizard.
Workaround Before Fix: None.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 10 (Defect 2554746).
Files Updated:

= Cobra.Process.dll

Security Enhancements

There are no security enhancements in this release.
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Database Changes

There are no database changes in this release.

Data Changes

There are no data changes in this release.

Documentation Changes

There are no documentation changes in this release.
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Cobra 8.7 Cumulative Update 01

Released: February 10, 2026

Enhancements

This section includes enhancements in this release.

Support for SMTP Email Using OAuth Authentication

PPM Administrator (PPMA) and EPM Security Administrator (EPM SA) now support sending email
through SMTP using Open Authorization (OAuth) 2.0 authentication. As part of this update, Cobra has
been enhanced to ensure full compatibility with this capability.

Attention: For more information on this enhancement, see the Deltek PPM Administrator 1.0.0

Cumulative Update 02 Release Notes.

The following items detail Cobra’s behavior when SMTP email is configured to use OAuth authentication:

= Emails are sent using OAuth authentication when you click the Forgot your password or user
ID? link in Cobra or when you click the Send Test Email button in PPMA or EPM SA, provided the
configured OAuth Flow type is Authorization Code, Authorization Code with PKCE, or Client
Credentials.

=  When the OAuth token has expired or the token status is None, Cobra uses Basic SMTP settings
to send email.

= Basic SMTP settings are used automatically when OAuth authentication fails.
= Email functionality works consistently across multiple attempts.

Support for Private Connections in Primavera Web Service Integration

When using the Integration Wizard to import data from Primavera using the Primavera Web Service, you
now have the option to mark a connection as private. This enhancement improves security and gives
users greater control over connection visibility, supporting secure, user-specific integration workflows.

In the New Connection dialog box, the Private checkbox has been added to enable you to mark the
connection as private. This checkbox is selected by default when creating new connections.
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New Connection Dialog Box of the Integration Wizard

Note: The same checkbox has been added to the Edit Connection dialog box.

Connections marked as private are only visible to users who created them and to the SYSADMIN users.
Once a connection is saved as private, it cannot be reverted to a shared connection. To share it again,
you must recreate the connection.

When editing a private connection, you can update the URL, user, password, and database instance.
However, the connection name and the Private checkbox are not editable.

Attention: For more information, see the “New Connection Dialog Box of the Integration Wizard-
Primavera Web Service” topic in the Cobra Help System.

In addition, the “Test the Connection in Cobra” section under Appendix G: Configuring Oracle
Primavera P6 for Integration of the Deltek Cobra 8.7 Installation Guide has been updated to reflect
this change.

Software Issues Resolved

This section includes software issues resolved in this release.

File » Backup

Defect 2558130

Description: When you pressed Ctrl+F in the Backup dialog box, the Find dialog box did not display.

Customers Impacted: This defect affects all customers.
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Workaround Before Fix: Right-click the column that you want to search and select Find.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 08 (Defect 2484728).
Files Updated:

= Cobra.WinUl.*dll

= CobraWinUl.exe

Files » Integration Wizard-Actual Costs

Defect 2558137

Description: When you ran the Actual Cost-Integration Wizard, the process took longer to complete
than expected while checking for duplicate keys or determining the current period and cumulative actual
costs.

Customers Impacted: This defect affects customers using the Actual Cost-Integration Wizard.
Workaround Before Fix: None.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 09 (Defect 2523431).
Files Updated:

= Cobra.Process.dll

Files » Integration Wizard-Ancillary Data

Defect 2558131

Description: When you ran the Ancillary Data-Integration Wizard to import a fixed-form significant code
file, Cobra proceeded with the integration even though the import file exceeded the specified maximum
character length.

Customers Impacted: This defect affects customers using the Ancillary Data-Integration Wizard.
Workaround Before Fix: None.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 09 (Defect 1424473).
Files Updated:

= Cobra.Process.dll

Files » Integration Wizard-Project Data

Defect 2558134

Description: When you ran the Integration Wizard and loaded Control Account Managers (CAMs) or
Work Package Managers (WPMs) from an import file, Cobra imported them based on the case of the
imported value rather than using the case of the User ID from EPM Security Administrator (EPM SA) or
the case of the code defined in the CAM code file.
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Customers Impacted: This defect affects customers using the Integration Wizard on a non-case-
insensitive database.

Workaround Before Fix: Manually update the CAMs or WPMs in the import file to match the case of the
code or the User ID from EPM SA before running the integration.

Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 09 (Defect 2523429).
Files Updated:

=  Cobra.Process.dll

Defect 2558133

Description: When you ran the Primavera Web Service-Integration Wizard on an n-tier deployment,
Cobra did not display the Primavera P6 projects in the Schedule Project field on the Project Selection

page.

Customers Impacted: This defect affects customers using the Primavera Web Service-Integration
Wizard on an n-tier deployment.

Workaround Before Fix: Perform the following steps:
1. Copy the PPM.P6WebServices.dll file from the Cobra directory to the Cobra\Server\ directory.
2. Restart the IdeaBlade PersistenceServer Service service on the server machine.
Additional Notes: This defect has been fixed in Cobra 8.6 Cumulative Update 09 (Defect 2484398).
Files Updated:
= DeltekCobra87.exe

Security Enhancements

There are no security enhancements in this release.

Database Changes

There are no database changes in this release.

Data Changes

There are no data changes in this release.

Documentation Changes

This section includes details of section changes in the printed documentation that are in addition to any
enhancements.
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Deltek Cobra 8.7 Help System

Deltek Cobra 8.7 Installation Guide

KB Article 124587 - SSL Certificate Error
Encountered When Connecting to a SQL
Database

Updated the following topics to include
additional and corrected information:

=  "Manual Performance Factors Page
of the Calculate Forecast Wizard"

= “Replace Resources”

Added the following sections to “Establish a
Database™:

= Required Database Permissions for
Cobra

= Required Database Permissions for
EPM Security Administrator

Created the KBA to provide instructions to
resolve SSL certificate error when
connecting to a SQL Server database

Cumulative Update O3 Release Notes
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Appendix A: Download and Install the
Cumulative Update

You can use Deltek Software Manager (DSM) to download complete Deltek products, hot fixes,

cumulative updates, and sub-releases. You can access DSM through the Deltek Support Center or use
Deltek Software Manager Lite to download Deltek products.

Access DSM and Download the Cumulative Update

Use these instructions to download the cumulative update from DSM.

To download the cumulative update:

1.

©® N o o o~ w N

10.

Using your web browser, go to https://dsm.deltek.com.

Enter your Deltek Support Center Username and Password, and click Login.
When the Deltek Support Center page displays, click Product Downloads.

On the Deltek Software Manager screen, click Launch Deltek Software Manager.
Click Run Deltek Software Manager.

Log in using your Deltek Support Center credentials.

In the Deltek Software Manager dialog box, at the top right, click Settings.

In the Settings dialog box, specify the folder where you want to download the Deltek products,
and click OK.

Note: When you log on for the first time, DSM asks you to select a default folder where
Deltek products are to be downloaded. You can change this folder anytime in the Settings
dialog box.

In the left pane, expand the Deltek product that you want to download, if it is not already
expanded, and select Cumulative Update.

In the table, select the checkbox that corresponds to the cumulative update that you want to
download.

The right pane displays a message stating that the product has been added to the download
queue.

Note: To view the items in the download queue, click View Download Queue at the bottom
of the left pane.

Cumulative Update O3 Release Notes 12
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11. Click Download at the bottom of the left pane to download the product to the folder that you
selected.
Install the Cumulative Update

The instructions for installing an update for Cobra 8.x and higher depend on your type of deployment.
Use the instructions below that apply to your deployment scenario.

Note: You must install the entire update package. If an update addresses more than one defect, you
cannot fix one defect at a time.

If You Use a Deployment Server

Use these instructions if you are using Cobra on a client/server (deployment server) deployment.

To install the cumulative update on the server:

1. Launch the update on the server.

Note: If the update detects that Cobra is already running, you will see a prompt asking if you
want to close Cobra. Click Yes to start the installation, or click No to cancel the installation.

2. The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation Wizard installs all necessary files and displays the Update Complete form.
3. Click Finish.

4. Depending on the type of update, a reboot may be required. If the option to reboot your
computer is enabled, select it and click Finish.

5. Launch the Deltek Cobra shortcut on client workstations to initiate the update.

To install the cumulative update on a client workstation:
1. Launch the Deltek Cobra shortcut.

Cobra detects that an updated version is available and displays the prompt: Do you want to
install the upgrade?

2. Click Yes to start the installation, or click No to cancel the installation.

When the installation is completed, the installation Wizard closes.

Cumulative Update O3 Release Notes 13



Deltek.

3. Launch the Deltek Cobra shortcut to log into Cobra.

If You Have an N-Tier Deployment

Use these instructions if you are using Cobra on an n-tier deployment.

To install the cumulative update on the server:

1. Launch the update on the server.

Note: If the update detects that Cobra is already running, you will see a prompt asking if you
want to close Cobra. Click Yes to start the installation, or click No to cancel the installation.

2. The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation Wizard installs all necessary files and displays the Update Complete form.
3. Click Finish.

4. Depending on the type of update, a reboot may be required. If the option to reboot your
computer is enabled, select it and click Finish.

5. Launch the Deltek Cobra shortcut on n-tier client workstations to initiate the update.

To install the cumulative update on an n-tier client workstation:
1. Launch the Deltek Cobra shortcut.

Cobra detects that an updated version is available and displays the prompt: Do you want to
install the upgrade?

2. Click Yes to start the installation, or click No to cancel the installation.

If you choose Yes, the installation Wizard copies the updated DeltekCobraWorkstation.exe file
locally and automatically begins installing files. When the installation is completed, the
installation Wizard closes.

Launch the Deltek Cobra shortcut to log into Cobra.

If You Have a Terminal Services/Citrix Deployment

Use these instructions if you are using Cobra on a terminal services/Citrix deployment.

To install the cumulative update on the deployment server:

1. Launch the update on the server.
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Note: If the update detects that Cobra is already running, you will see a prompt asking if you
want to close Cobra. Click Yes to start the installation, or click No to cancel the installation.

The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation Wizard installs all necessary files and displays the Update Complete form.
Click Finish.

Depending on the type of update, a reboot may be required. If the option to reboot your
computer is enabled, select it and click Finish.

Log on as a Local Administrator on the Terminal Server/Application Server and install the update.

To install the cumulative update on the Terminal Server/ Application Server (the server on which the

Cobra client runs):

1.

Log onto the Terminal Server using an account that has Local Administrator privileges.

When the setup launches, the installation program installs all necessary files and any registry
updates and makes these changes available to all users who will subsequently log on to the
Terminal Server session to run Cobra.

Ensure that no instance of Cobra is running.

Open the shared Cobra Workstation folder (usually located on the deployment server, as
\\{DeploymentServerName}\CobraWorkstation\DeltekCobraWorkstation.exe).

Launch the DeltekCobraWorkstation.exe file to install the update.
The Welcome screen displays, showing that the update is available.
Click Next to start the installation.

When the installation completes, launch the Deltek Cobra shortcut to log into Cobra and confirm
that the update is installed, meaning that users can now launch Cobra via Terminal
Services/Citrix sessions.

If You Have a Stand-Alone Deployment

Use these instructions if you are using Cobra on a stand-alone deployment.

To install the cumulative update on the workstation:

1.

2.

Verify that Cobra is not running.

Launch the update on the server.
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3. The Welcome screen displays the current build, along with the new build being installed by the
update. Click Next to begin the installation.

The installation Wizard installs all necessary files and displays the Update Complete form.
4. Click Finish.

5. Depending on the type of update, a reboot may be required. If the option to reboot your
computer is enabled, select it and click Finish.

6. Launch the Deltek Cobra shortcut to log into Cobra.

Confirm that the Cumulative Update Is Installed

Use these instructions to check that the version number reflects the installed cumulative update.

To confirm that the cumulative update is installed:

.

1. Click {v} » Help » About Deltek Cobra.

2. Check that the version number reflects the installation of the update.

Cumulative Update O3 Release Notes 16
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Appendix B: For Additional Information

Deltek Support Center

The Deltek Support Center is a support Web site for Deltek customers who purchase an Ongoing
Support Plan (OSP).

The following are some of the many options that the Deltek Support Center provides:

Search for product documentation, such as release notes, install guides, technical information,
online help topics, and white papers

Ask questions, exchange ideas, and share knowledge with other Deltek customers through the
Deltek Support Center Community

Access Cloud-specific documents and forums

Download the latest versions of your Deltek products

Search Deltek’'s knowledge base

Submit a support case and check on its progress

Transfer requested files to a Deltek Support Services analyst
Subscribe to Deltek communications about your products and services
Receive alerts of new Deltek releases and hot fixes

Initiate a Chat to submit a question to a Deltek Support Services analyst online

Attention: For more information regarding Deltek Support Center, refer to the online help available
from the Web site.

Access Deltek Support Center

To access the Deltek Support Center:

1.
2.
3.

Go to https://deltek.custhelp.com.

Enter your Deltek Support Center Username and Password.

Click Login.

Note: If you forget your username or password, you can click the Need Help? button on the login

screen for help.
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